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Saturn DigiSizer II 5205 Introduction 
Introduction

This document describes how to install and verify operation of the Saturn DigiSizer II 5205. 
The Saturn DigiSizer 5205 software is available as either a Standard analysis system or a 
confirm analysis system. This document contains instructions for a typical Saturn DigiSizer 
5205 standard or confirm installation. Follow the instructions applicable for the type of system 
the customer purchased.

An installation checklist is included following the instructions. Complete each item in the 
checklist and return the checklist to Micromeritics. 

In addition to the steps described in this checklist, the Micromeritics Installation Qualification 
Package for the Saturn DigiSizer 5205 and the Micromeritics Operational Qualification 
Package for the Saturn DigiSizer 5205 may be completed during installation.

Conventions

Symbols

This document uses the symbols shown below to identify notes of importance, cautions, and 
warnings.

Notes contain important information pertinent to the subject matter.

Warnings contain information that helps you prevent actions that may cause personal 
injury.

Cautions contain information that helps you prevent actions that may damage the 
analyzer.
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Conventions Saturn DigiSizer II 5205
Commands

Menu commands are represented as shown in the following example: 

Select Unit1 > Rinse > DigiSizer.

Which means, select Unit1, then Rinse, then DigiSizer from the main menu.

Command buttons in dialog boxes are shown in bold type. For example: Click OK to close the 
dialog box.
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Saturn DigiSizer II 5205 Preparing for Installation 
Part 1: Installation Instructions

Preparing for Installation

Before you begin installation of the Saturn DigiSizer 5205, perform these steps:

• Thoroughly review the Preinstallation Checklist, which has been returned from the cus-
tomer. 

The Preinstallation Checklist and Instructions have been written to ensure that the 
customer site is ready for this installation. In addition, the customer has been notified that 
the installation will proceed smoothly if all of the items on the checklist are completed 
properly.

• The Preinstallation Checklist helps you perform the steps described in the Installation 
Instructions. If there are ANY discrepancies on the Preinstallation Checklist, contact the 
customer and explain how the installation will be affected.

For a successful installation, you will need the following:

Item Purpose Location

Installation 
Instructions

To provide step-by-step instructions 
for each procedure.

Make sure you follow the procedures 
in the order in which they are 
presented to ensure a successful 
installation. 

If the user has not purchased an 
option, for example, a MasterTech, 
skip the instructions for that 
component and proceed to the next 
step.

In this document.

 Installation Checklist To list the procedures required for the 
installation process and verify 
completion of each procedure.

In this document. 

Standard Service 
Tool Kit, safety 
glasses, and 
protective gloves

To provide the tools required for a 
proper, safe installation.

Provided by the Service 
Representative.
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Equipment Description Saturn DigiSizer II 5205
Equipment Description

The Saturn DigiSizer 5205 System consists of up to two particle size analyzers, each with a 
liquid sample handler, an AquaPrep, and one multifunction personal computer. Up to two 
MasterTech 052 Autosamplers can be installed, allowing automatic analysis of up to 18 
samples each.

Analyzer

The Saturn DigiSizer uses a laser in conjunction 
with a CCD (charge-coupled device) containing 
over three million detector elements to measure 
particle size. These detectors are placed so that 
they can measure the intensity of light scattered 
by the particles at various angles. Light is 
scattered by particles in a pattern dependent on 
their size, shape, refractive index, and wave 
length of incident light. Based on the Mie 
theory, the particle size distribution is calculated 
from the angle distribution of the scattered light 
intensity collected by the detectors. 

  Saturn DigiSizer 5205 Analysis System

             
Liquid Sample
Handler

Analyzer

AquaPrep
AquaPrep
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Saturn DigiSizer II 5205 Equipment Description 
Both organic and inorganic particles can be analyzed and measured over a range of 0.06 to 
2100 micrometers. The Saturn DigiSizer includes a complete system for circulating the 
dispersing liquid/sample mixture through the cell and reservoir, as well as to an external waste 
container.

Liquid Sample Handler

The Saturn DigiSizer requires the use of a liquid sample 
handler to transfer the sample to the analyzer for analysis. 
The sample handler also allows for connection of an 
ultrasonic probe to assist in sample dispersion.

The sample handler enables automatic sample handling. All 
the user has to do is define analysis conditions (in the 
sample file), add the sample to the reservoir (containing the 
dispersing liquid), and start the analysis. The sample will be 
automatically monitored and diluted when necessary; and 
the system rinsed after each analysis (when specified in the 
sample file).

The Liquid Sample Handler is available in two configurations: 

• Standard unit: includes a reservoir that holds 500 to 600 mL of dispersed sample. This 
model is best suited for samples containing coarse particles or for those of high density. 

• Low-Volume unit: includes a reservoir that holds 100 to 120 mL of dispersed sample. 
This model is best suited for analyses where the sample quantity or dispersion liquid is 
limited, or where the dispersion liquid may be hazardous or difficult to dispose of. 

You also can attach a MasterTech 052 which allows you to analyze up to 18 samples 
sequentially without further intervention. The MasterTech automatically transfers each sample 
to the liquid sample handler for analysis. 
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Equipment Description Saturn DigiSizer II 5205
AquaPrep

Tap water varies greatly in its dissolved air 
content and the presence of debris. This water 
must be deionized and well filtered before using 
with the AquaPrep. 

Filtering the water through (at least) a 1-micron 
filter will greatly extend the life of the 
hydrophobic capsule by means of which air is 
removed.

The AquaPrep recirculates water through a 
hydrophobic capsule consisting of capillaries. 
The result is a diffusion of dissolved air from the 
water through the capillary walls and into the 
ambient air.

The AquaPrep has water inlet and outlet connectors on its front panel. The switch for turning it 
on and off is located on the rear panel just left of the power cord entrance.

The air removed from the water is exhausted through a small tube also at the front of the 
instrument. Placing a small beaker of water around the tube so that its vent is submerged 
reveals by its bubbling the rate of air removal. This guides in assessing when sufficient air has 
been extracted from the water. Not all dissolved air has to be removed for satisfactory use with 
the DigiSizer.

MasterTech 052

The MasterTech 052 is an optional automatic sampling device that operates in conjunction 
with the Saturn DigiSizer. The MasterTech allows you to queue as many as 18 predispersed 
samples to run consecutively and unattended. It allows samples to be redispersed either by 
stirring only or by stirring and disruption with an ultrasonic probe. 
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Saturn DigiSizer II 5205 Completing the Installation Checklist 
During operation, the beaker tray is loaded with beakers containing predispersed sample. 
When the Saturn DigiSizer is ready for a sample, the tray rotates until in the correct position 
for transfer. The sample is stirred for a user-specified length of time just before transfer to the 
Saturn DigiSizer for analysis. The ultrasonic probe can also be activated for a user-specified 
length of time to assist in redispersion if needed.

After redispersion, the sample is transferred to the reservoir of the analyzer. Then a small 
amount of analysis fluid is back-flushed to the MasterTech to rinse the stirrer, probe, and 
tubing. After rinsing is complete, the MasterTech prepares itself for the next sample. 

Completing the Installation Checklist

Section 2 of this document contains the Installation Checklist. For each operational 
verification procedure, fill in the values obtained in the test. When you complete the checklist, 
fill in the customer information, sign and date, and return the checklist to Micromeritics 
Service Center as described below.

Documenting Installation 

In order to provide consistent instrument service, Micromeritics retains records of installation, 
operational verification, and calibration data in its Service Support Center in Norcross, 
Georgia, USA. After completing the installation process, representatives of Micromeritics 
who install instruments are required to send the documents listed below to Micromeritics for 
inclusion in the customer's instrument history file. 

For sample information files and calibration data, you may either save the files on CD and 
mail the CD to Micromeritics or send them as an email attachment.

The mailing address is:

Micromeritics Service Support Center 
4356 Communications Drive 
Norcross, GA 30093 
USA

The email address is:

service-support@micromeritics.com
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Inspecting the Equipment Saturn DigiSizer II 5205
The documents to be sent to the Micromeritics Service Support Center are:

• Saturn DigiSizer 5205 Installation Checklist, completed and signed 
• Reference Material Analysis Sample File
• Laser Diagnostics Report
• Laser Stability Test Report
• Calibration files if instrument calibration data are changed during installation.*

*Generally, it is not necessary to change calibration data during installation. If however, you 
need to change calibration data, the calibration files must be saved and sent to Micromeritics 
for retention in the instrument history file.

Inspecting the Equipment

Before you begin installing the Saturn DigiSizer 5205, check the packing list to ensure that all 
components and accessories are available. 

If the analyzer has not been unpacked, the customer must unpack the analyzer and 
place it on an appropriate work surface before you can proceed with the installation.

If the customer needs to declare equipment as damaged or lost, the customer must 
save the shipping cartons. The claims investigator must examine the cartons in order 
to complete the inspection report.

The Saturn DigiSizer analyzer weighs 45 kg (99 lbs) and requires the use of two 
people to lift it from its shipping carton. One person should not attempt to lift the 
analyzer. With one person on each side of the analyzer, lift it upright from its shipping 
carton.
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Saturn DigiSizer II 5205 Setting up the DigiSizer System 
Setting up the DigiSizer System

Installing the DigiSizer

Space Requirements

The Saturn DigiSizer System requires the work space shown below.

Placing the DigiSizer on a Work Surface

Ensure that the DigiSizer is placed on the work surface with the back panel facing the front of 
the table in order to access the fuse block.

You must have access to the front, side, and rear panels for installation of the 
instrument.
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Setting up the DigiSizer System Saturn DigiSizer II 5205
Selecting the Voltage Setting and Installing the Fuses

The Saturn DigiSizer leaves the factory set for 120 VAC and with the line fuses removed. The 
correct setting of the universal power entrance must be checked and the appropriate fuses 
installed before the analyzer can be operated. 

The Saturn DigiSizer is designed to operate with 100, 120 or 220, 240 VAC from 47 to 63 Hz. 
Voltage selection and fusing are made at the power connector located on the rear panel of the 
analyzer. Appropriate fuses are included in the accessories kit: 

• Two 5x20mm, SLO-BLO, 1.6A (100 - 120 VAC)

• Two 5x20mm, SLO-BLO, 1.25A (220 - 240 VAC)

1. Make sure the power cord is not connected. 

2. Check the voltage setting at the power connector on the rear panel of the instrument. 

• If the voltage is correct:

a. Open the cover by prying the left side of the cover with a pointed object, such as a 
small flat-blade screwdriver.

b. Remove the fuse block.

c.  Proceed to Step 6.

• If the voltage is incorrect, open the cover and remove the fuse block as described above, 
then proceed to Step 3.

3. Using a pointed object, pry the voltage selector card loose and remove it from the power 
connector housing.
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Saturn DigiSizer II 5205 Setting up the DigiSizer System 
4. Orient the voltage selector card so that the desired voltage is shown on the side of the card 
facing you.

5. Slide the voltage selector card into the power connector housing and press until it fits 
securely.

6. Insert the appropriate fuses into the fuse block. Refer to the chart below for the appropriate 
fuse rating.

Power Source                    Fuse                    
            100 - 120 VAC               Two 5x20mm, SLO-BLO, 1.6A 
            220 - 240 VAC               Two 5x20mm, SLO-BLO, 1.25A

7.  Slide the fuse block into the housing and press until it fits securely.

Voltage
setting

The fuses used in the instrument must be identical in type and rating to that specified. 
Use of other fuses could result in electrical shock and/or damage to the instrument.
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Setting up the DigiSizer System Saturn DigiSizer II 5205
Selecting the Computer Line Voltage

The line voltage of the computer must be set to match the input power source (from the wall 
outlet). The computer operates with either 100-120 VAC or 200-240 VAC at 50 or 60 Hz. 
Refer to the instruction manual supplied with your computer for instructions on selecting 
power input.

Connecting Cables

Ethernet Cable

The Ethernet cable has RJ45 connectors (similar to a phone jack). Either a straight-through 
patch cable or a crossover cable can be used. Install the cable as follows:

1. Insert one end of the Ethernet crossover cable into the connector labeled Ethernet on the 
rear panel of the analyzer.

2. Insert the other end of the cable into the RJ45 connector on the ethernet card (exposed on 
the rear panel of the computer).

Do not connect the computer power cord to a power source until the proper voltage 
selection is made. Doing so could result in electrical shock and/or damage to the 
computer.
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Saturn DigiSizer II 5205 Setting up the DigiSizer System 
Power Cord

Connect the power cord to the connector on the rear panel of the DigiSizer and to an 
appropriate power source.

Computer Cables

Follow the instructions provided below to connect the monitor, keyboard, printer, and mouse.
 

1. Plug the keyboard cable, the monitor cable, and the mouse cable into their respective 
connectors on the rear panel of the computer. 

2. Plug one end of the printer cable into the connector on the rear panel of the printer. Plug 
the other end of the printer cable into the appropriate connector on the rear panel of the 
computer.

3. Plug all power cords into an appropriate power source.

Refer to the instruction manuals supplied with the computer, video monitor, and 
printer for voltage requirements for these units.
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Setting up the DigiSizer System Saturn DigiSizer II 5205
Installing the Liquid Sample Handling Unit

A liquid sample handler is required to transfer the sample to the analyzer for analysis. The 
sample is transferred through the use of tubing. This tubing is installed on the left side of the 
sample handler and inserted through two ports on the right side of the analyzer. Precut tubing 
is provided for this purpose; if you are installing the:

• Standard unit, the tubing is 1.27-cm (1/2-in.) diameter (2 pieces)
• Low-volume unit, the tubing is 0.79-cm (5/16-in.) diameter (1 piece)

Perform the following steps to install the liquid sample handler. 

1. Remove the two plugs from the ports on the side of the sample handler

If you are installing the Low-volume unit, the tubing on the upper port is installed; remove 
the plug from the end of the tubing.

2. Install the tubing onto the connectors provided on the left side of the liquid sample 
handler. One piece of tubing is approximately 2 inches longer than the other; install this 
piece on the upper connector and the shorter one on the lower connector.

3. Install the tubing onto the connectors provided on the left side of the liquid sample 
handler. One piece of tubing is approximately 2 inches longer than the other; install this 
piece on the upper connector and the shorter one on the lower connector.

Longer piece on upper port.

This piece of tubing is 
already installed if you have 
the Low-volume unit.

Shorter piece on lower port.
14                                         Jul 09



Saturn DigiSizer II 5205 Setting up the DigiSizer System 
4. Open the front panel of the analyzer.

a. The front panel contains a retractable handle; press on the right side to protract the 
handle.

b. Grasp the handle and lift upward to open the front panel.

5. The cover of the sample cell compartment is held in place by three captive, thumb screws. 
Turn each screw counterclockwise and remove the cover.

6. Remove the foam block supporting the rotation arm. The rotation arm should be elevated 
and out of the way of the sample cell holder location.

Press here to protract the handle.

Sample cell compartment

Captive thumb screws
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Setting up the DigiSizer System Saturn DigiSizer II 5205
7. Unpack the sample cell holder and attach it with the two screws provided.

8. Remove the plugs from the ports on the inside, right side of the analyzer to allow 
installation of the sample transfer tubing.

9. Place the liquid sample handler to the right side of the analyzer.

Sample cell holder

Attach with the two phillips-head 
screws provided

If the rotation arm is blocking access to the sample cell holder location, do not 
attempt to move it. The arm is controlled through the DigiSizer software. 
Instructions are provided for moving the arm after the software is installed. (Refer 
to “Moving the Rotation Arm to the Specified Angle” on page 69.)

If this is the case, do not install the sample cell holder until you have moved the 
rotation arm using the software.
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Saturn DigiSizer II 5205 Setting up the DigiSizer System 
10. Slide the liquid sample handler toward the analyzer, guiding the tubing through the ports 
on the right side of the analyzer.

11. Attach the sample transfer tubing to the sample cell holder as shown below.

12. Attach the RS232 communications cable as follows:

a. Connect one end of the cable to the port labeled RS232 From Saturn Analyzer on the 
rear panel of the liquid sample handling unit.

b. Connect the other end of the cable to the port labeled Sample Handling Unit RS232 on 
the rear panel of the analyzer.

Tubing Ports Liquid Sample Handler

Avoid touching the lens when installing the tubing. Dirty, or smudged optics, will 
affect analysis results.
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Setting up the DigiSizer System Saturn DigiSizer II 5205
13. Plug the liquid sample handler’s power cord into an appropriate power source. The liquid 
sample handler is equipped with universal power input; therefore, voltage selection is 
unnecessary.

Installing the Sample Cell

The sample cell should always be kept clean to ensure collection of accurate data. Observe the 
following precautions when handling the sample cell:

• Avoid touching the smooth surfaces of the sample cell; always hold the cell by the edges.

• Never place the sample cell on anything other than a lens paper (a supply of lens papers is 
provided in the accessories kit).

• Handle the sample cell carefully to avoid replacement costs.

Follow the instructions provided below to install the sample cell into the sample cell holder.

1. Loosen the two knurled nuts on the top bracket of the sample cell holder. Then pull up on 
the bracket to allow placement of the sample cell. 

2. Remove the sample cell from its container.

If the rotation arm is blocking access to the sample cell holder, do not install the 
sample cell at this time. The arm is controlled through the DigiSizer software. 
Instructions are provided for moving the arm after the software is installed. (“Moving 
the Rotation Arm to the Specified Angle” on page 69.)

After installing the software and moving the arm, return to these instructions to install 
the sample cell.

The sample cell is coated with an anti-reflective substance. Be careful not to scratch 
this coating. Also avoid touching the front and back surfaces of the sample cell to 
prevent fingerprints.
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Saturn DigiSizer II 5205 Setting up the DigiSizer System 
3. The sample cell is grooved on the left side and angled slightly on the right, front side. 
Holding the sample cell by the edges, slide the grooved (left) side of the cell onto the left 
vertical bar.

4. Swing the sample cell into place (against the right vertical bar).

5. Slide the top bracket of the sample cell holder down.

6. Tighten the knurled nuts.

Installing the Liquid Sample Handler Tubing

The following items for installing the tubing are provided in the accessories kit:

• Appropriate plastic containers for the analysis, rinse, overflow, and waste (drain) liquids
• Precut pieces of Tygon tubing for the analysis, rinse, overflow, and drain function 

 

.
1. Prepare the containers and connect the tubing as follows:

2. Prepare the containers:

a. Place the rinse and analysis liquid containers on the floor in front of the liquid sample 
handler; remove the caps.

b. Pour approximately 10 liters of deiozined water with 0.0005% sodium metaphosphate 
(W/W) into the analysis liquid container. 

    If your rinse and analysis liquids are the same or if you are installing the Low-volume 
unit, skip step c. Be sure to access the Unit configuration dialog and specify that the 
rinse and analysis liquids are the same.

Knurled nuts

Left grooved side

Right front side

The Low-volume unit uses the same liquid for analysis and rinsing. Therefore, it does 
not require attachment of rinse tubing, rinse pump, or a separate rinse container. 
Ignore all references to the rinse tubing and container in this procedure if you have 
the Low-volume unit.
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Setting up the DigiSizer System Saturn DigiSizer II 5205
c. Pour approximately 10 liters of water into the rinse container. It may be necessary to add 
a small amount of surfactant for difficult-to-rinse materials. For example, you may wish 
to use 0.0005% sodium metaphosphate (W/W) in deionized water.

d. Place the waste container on the floor beside the rinse and analysis containers. If you 
plan to use a MasterTech with the standard sample handler, replace the 5-gallon 
container with one that will hold at least 10 gallons. If available, a direct-drain system 
would be more desirable when using the MasterTech.

e. Label the containers appropriately.

3. Remove the plugs from the tubing ports on the front panel of the liquid sample handler.

4. Install the tubing onto the ports of the liquid sample handler as described below.

The two pieces of 0.64-cm (1/4-in.) diameter tubing are installed on the two upper ports 
(analysis and rinse). 

The 0.79-cm (5/16-in.) diameter tubing (drain) is installed on the lower left port and the 
1.27-cm (1/2-in.) diameter tubing (overflow) is installed on the lower right port.

5. Insert the other ends of the drain tubing and the overflow tubing just inside the waste 
container. Use a clamp or similar device to ensure that the tubing is kept above the liquid 
level or cut the tubing so that the ends are just inside the container. If the tubing is allowed 
to become immersed in liquid, timeout errors will occur.

6. Insert the other ends of the rinse and analysis tubing into the cap(s) of their respective 
containers, then install a weight onto the end of each tubing.

                                                                                              

Overflow tubing

Rinse tubing
(not installed on
low-volume unit)

  Analysis tubing

     Drain tubing
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Saturn DigiSizer II 5205 Setting up the DigiSizer System 
7. Place the cap(s) on the container and tighten; ensure that the tubing is resting on the 
bottom of the rinse and analysis liquid container(s).

Do not allow any of the tubing to form a loop so that flow is restricted; cut the tubing if 
required.

Analysis Tubing

Rinse Tubing

D

Drain       Overflow
Tubing     Tubing
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Setting up the DigiSizer System Saturn DigiSizer II 5205
Connecting the Ultrasonic Controller Unit

Connect the ultrasonic controller unit to the probe as follows:

1. Place the ultrasonic controller unit on top of the liquid sample handler.

2. Connect one end of the 9-pin RS232 M/F straight communication cable to the I/O 
connector on the rear of the controller unit.

3. Insert one end of the ultrasonic probe BNC cable into the probe connector.

4. Insert appropriate fuse(s) for the input power source. Refer to the following chart for the 
appropriate fuse rating.

Power Source                   Fuse                         
100-120 VAC 3AG, 3.0 Amp Slow-Blow
200-240 VAC 5x20 mm, 1.6 Amp Slow-Blow (Type T)

5. Ensure that the line voltage is set to match that of the input power source. Refer to the 
manufacturer’s User’s Guide shipped with the ultrasonic probe for instructions on setting 
the line voltage.   

6. Connect the power cord to the power connector and plug into an appropriate power 
source.

7. On the rear panel of the liquid sample handler in the area labeled Ultrasonic Probe:

a. Connect the other end of the communication cable (from the ultrasonic controller) to the 
connector labeled Controller.

Voltage Selector Card

Power Switch

Power Connector

I/O Connector                   Probe Connector
(for communication
cable)

The fuses used in the ultrasonic controller unit must be identical in type and rating to 
that specified. Use of other fuses could result in electrical shock and/or damage to 
the unit

Do not connect the ultrasonic power cord to a power source until the proper voltage 
selection is made. Doing so could result in electrical shock and/or damage to the 
ultrasonic unit.
22                                         Jul 09



Saturn DigiSizer II 5205 Setting up the DigiSizer System 
b. Insert the other end of the ultrasonic probe cable into the connector labeled Probe.

8. Place the control unit power switch in the ON position.

The operation of the ultrasonic probe is controlled through the analysis software.

Installing the AquaPrep

Ideally the AquaPrep should be placed next to the liquid sample handling module of the 
DigiSizer. This allows for easy transfer of the container of deaerated water from the AquaPrep 
to the sample handling module.

 Controller
 

                 Probe

DigiSizer                          Liquid Sample Handler    

AquaPrep
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Selecting the Input Power

The AquaPrep leaves the factory set for 120 VAC and with the line fuse removed. The correct 
setting of the universal power entrance must be checked and the appropriate fuse installed 
before the AquaPrep can be operated. The AquaPrep is designed to operate with either 100, 
120, 220 or 240 VAC at 50 or 60 Hz. Voltage selection and fusing are made at the power 
connector which is located on the rear panel of the unit.

Spare fuses are also included.

1. Make sure the power cord is not connected. The cover of the input power connector 
cannot be opened with the power cord installed.

2. Check the voltage setting on the rear panel of the instrument. 

• If the voltage is correct:

a. Open the cover by prying the right or left side of the cover open with a pointed object, 
then swinging the cover to the left.

b. Remove the fuse block.

b.  Proceed to Step 6.

• If the voltage is incorrect, open the cover and remove the fuse block as described above, 
then proceed to Step 3.

On some instruments, the input power connector has a removable cover instead of 
the hinged cover described below. If the unit you are installing has a removable cover, 
refer to the instructions in Appendix C rather than those below.
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3. Pull the voltage selector card straight out of the power connector housing.

4. Orient the voltage selector card so that the desired voltage is indicated at the bottom. 
Orient the indicator pin so that it points upward as shown in the following illustration.

5. Insert the voltage selector card into the power connector housing with the edge containing 
the desired voltage first and with the printed to the left.

6. Fuse the input power line according to local safety practices. The input power connector 
can be used with either a single-fuse arrangement or a double-fuse arrangement.

a. If the single-fuse arrangement is desired, position the fuse block so that the side with 
the single-fuse slot and the jumper bar is away from the cover. 

If the double-fuse arrangement is desired, position the fuse block so that the side with 
the double-fuse slots is away from the cover.

Indicator Pin

Voltage

Printed Side
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b. Insert appropriate fuse(s) for the input power source. Refer to the chart below for the 
appropriate fuse rating.

Power Source                    Fuse                    
100-120 VAC 2.0 Amp (slow-blow)
200-240 VAC 1.0 Amp (slow-blow)

7. Insert fuse block into the input power connector (as shown in the following illustration) 
and snap it into place, then close the cover. Once the fuse block and cover are in place, the 
position of the indicator pin shows the input power selected.

The fuses used in the equipment must be identical in type and rating to that specified. 
Use of other fuses could result in electrical shock and/or damage to the equipment.
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Installing the AquaPrep Tubing

The AquaPrep has inlet and outlet connectors onto which tubing is installed for circulating the 
water through the AquaPrep for degassing.

1. Install the two pieces of tubing (supplied in the accessories kit) into the connectors located 
on the right side of the front panel.

2. Fill a 10-liter, plastic container with deionized water which has been filtered with a 1-
micron filter. Place the container on the floor directly below the AquaPrep.

3. Insert the other ends of the tubing into the water. Orient the tubing as follows:

• The end of the inlet tubing (supply) should be close to the bottom of the container.

• The end of the outlet tubing (return) should be just below (approximately 5 cm, or 2 in.) 
the surface of the water so that splashing does not re-introduce air into the liquid.

It is important that the tubing is arranged at different levels. This promotes circulation and 
ensures that all the liquid is exposed during the deaeration process.

Tubing Connectors

The AquaPrep works only with water; do not use any other liquid. Do not use water 
that contains a detergent or wetting solution.
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Connecting the Power Cord

Insert one end of the power cord into the input power connector on the rear panel of the 
AquaPrep and the other end into an appropriate power source.

Do not turn on the power switch until you are ready to begin operation.

Outlet Tubing

Inlet Tubing

Do not turn on the AquaPrep until the water is prepared and ready for deaeration. 
Failure to have water circulating while the unit is turned on may damage the unit.
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Installing the MasterTech (Optional)

The MasterTech is an optional device. Skip these instructions if the customer did not purchase 
a Master Tech. 

Removing Packing Material From the Unit

After removing the MasterTech from the shipping carton, remove all foam packing material 
from the unit before proceeding with installation.

Selecting the Voltage

The MasterTech 052 leaves the factory set for 120 VAC and with the line fuse removed. The 
correct setting of the universal power entrance must be checked and the appropriate fuse 
installed before the MasterTech can be operated. The MasterTech is designed to operate with 
either 100, 120, 220 or 240 VAC at 50 or 60 Hz. Voltage selection and fusing are made at the 
power connector, which is located on the rear panel of the unit

1. Make sure the power cord is not connected. The cover of the input power connector 
cannot be opened with the power cord installed.

2. Check the voltage setting on the rear panel of the instrument. 

• If the voltage is correct:

a. Open the cover by prying the right or left side of the cover open with a pointed object, 
then swinging the cover to the left.

On some instruments, the input power connector has a removable cover instead of 
the hinged cover described below. If the unit you are installing has a removable cover, 
refer to the instructions in Appendix C rather than those below.
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b. Remove the fuse block.

b.  Proceed to Step 6.

• If the voltage is incorrect, open the cover and remove the fuse block as described in 
steps a and b above, then proceed to Step 3.

3. Pull the voltage selector card straight out of the power connector housing.
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4. Orient the voltage selector card so that the desired voltage is indicated at the bottom. 
Orient the indicator pin so that it points upward as shown in the following illustration.

5. Insert the voltage selector card into the power connector housing with the edge containing 
the desired voltage first and with the printed side to the left.

6. Fuse the input power line according to local safety practices. The input power connector 
can be used with either a single-fuse arrangement or a double-fuse arrangement.

a. If the single-fuse arrangement is desired, position the fuse block so that the side with 
the single-fuse slot and the jumper bar is away from the cover. 

If the double-fuse arrangement is desired, position the fuse block so that the side with 
the double-fuse slots is away from the cover.

b. Insert appropriate fuse(s) for the input power source. Refer to the chart below for the 
appropriate fuse rating.

Power Source                    Fuse                    
100-120 VAC 3AG, 2.00 Amp Slow-Blow
200-240 VAC 5x20 mm, 1.00 Amp Slow-Blow (Type T)

Indicator Pin

Voltage

Printed Side

The fuses used in the instrument must be identical in type and rating to that 
specified. Use of other fuses could result in electrical shock and/or damage to the 
instrument.
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7. Insert fuse block into the input power connector (as shown in the following illustration) 
and snap it into place, then close the cover. Once the fuse block and cover are in place, the 
position of the indicator pin shows the input power selected.
32                                         Jul 09



Saturn DigiSizer II 5205 Setting up the DigiSizer System 
Turning on the MasterTech (If Used)

1. Make sure the proper operating voltage and fuse are selected and in place.

2. Insert the power cord into the connector on the rear panel of the MasterTech and into an 
appropriate power source.

3. Place the POWER ON/OFF switch, located on the MasterTech rear panel, in the ON ( | ) 
position. The +5 and +24 LEDs on the rear panel and some of the LEDs in the front panel 
switches should illuminate.

4. Press the ARM AUTO/LOAD switch on the front panel of the MasterTech. The arm 
should rise to the Load position, which is used for removal and replacement of the tray.

Power On/Off Switch                        RS232 Connector

+5 and +24 VDC Indicators

The ultrasonic probe should not be turned on at this point. Observe the indicator on 
the ULTRASONIC PROBE AUTO/ON switch on the front panel of the MasterTech 
(shown in the following illustration). If the indicator below ON is illuminated, press the 
switch to turn off the probe. The indicator below AUTO should illuminate.

Power Display
Intensity Control

Pump Auto/Off
Switch

Ultrasonic Probe     Arm Auto/Load
Auto/On Switch       Switch
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Installing the Ultrasonic Probe

1. Make sure that the power ON/OFF switch on the rear panel of the MasterTech is in the 
OFF (O) position.

2. Attach the probe cable to the connector labeled Ultrasonic Probe.

3. Ensure that the probe tip is attached to the probe; if not, attach it. A 1/4-in. probe tip is 
supplied with the MasterTech 052. A 1/8-in. tip is also available. 

4. Insert the cylinder into the arm, positioning it so that the longer slots slide over the 
protrusions inside the arm. 

5. Insert the probe into the cylinder.

Make sure that no power is supplied to the unit before starting this procedure.

Cable Ultrasonic Probe

Cylinder

Arm

Position the shorter slots of the cylinder over the protrusions if you are using the  
1/8-in. probe.
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Installing the Beaker Tray

1. Place the POWER switch in the ON position.

2. Make sure the arm of the MasterTech is in the LOAD (uppermost) position; the LOAD 
LED will be illuminated. If the LED is not illuminated, press the ARM AUTO/LOAD 
switch.

3. Hold the tray firmly by the outside edge. Notice that the bottom of the tray has small slots 
positioned radially outward from the inside edge. Place the tray on the MasterTech so that 
the arm passes through the center opening of the tray.

4. Make sure the drive pin is lined up into a radial slot on the bottom of the tray. The position 
of the tray does not matter at this point.
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Installing Sample Transfer Tubing

The MasterTech accessories kit contains two pieces of flexible tubing. One piece of tubing is 
for installation inside the MasterTech arm. The other piece of tubing is installed inside the 
liquid sample handler, allowing for connection to the MasterTech.

MasterTech Installation

1. Ensure that the MasterTech POWER switch is in the ON position.

2. Make sure the arm is in the LOAD (uppermost) position; the LOAD LED is illuminated. If 
the LED is not illuminated, press the ARM AUTO/LOAD switch.

3. Press the end of one segment of flexible tubing over the sample transfer tube until there is 
at least 1/2-in. overlap. 

4. Unlatch the pump housing and unscrew the plastic knob on the rear of the pump. 

5. Thread the tubing through the pump as shown above and attach it to the rigid tubing 
labeled L (left) or R (right). Choose the rigid tubing labeled with the side of the 
MasterTech from which you want the fluid to be discharged.

6. Close and latch the housing. Tighten the plastic knob on the rear of the pump sufficiently 
to prevent tubing slippage but not enough to restrict flow through the tubing.

A

B

Plastic Knob

Sample Transfer Tube

Flexible Tubing

Arm

Rigid Tubing

Pump

Pump Housing
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Liquid Sample Handler Installation

The following steps are common to both liquid sample handlers. 

1. Place the MasterTech to the right of the liquid sample handler.

2. If the liquid sample handler contains liquid: 

a.  Select Unit[n] > Drain > DigiSizer.

b.  Turn off the liquid sampler and the analyzer.

3. Remove the retaining screws on the right side of the liquid sample handler.

4. Loosen the captive thumb screw on the rear panel.
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5. Lift off the cover and set aside.
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Liquid Sample Handler Installation

The following steps are common to both liquid sample handlers. After performing these steps, 
advance to the section applicable to the liquid sample handler you have connected to your 
analyzer.

1. Select Unit [n] > Drain > DigiSizer to remove any liquid that may be in the liquid sample 
handler.

2. Turn off the liquid sampler and the analyzer.

3. Remove the retaining screws on the right side of the liquid sample handler, then loosen the 
captive thumb screw on the rear panel.

4. Lift off the cover and set aside.

Standard Liquid Sample Handler

1. Locate the analysis liquid inlet tubing on the inside of the liquid sample handler. 

2. The analysis tubing has a connector approximately two inches from the inlet fitting; 
remove this connector.

3. Using the T-connector supplied in the MasterTech accessories kit, reconnect the tubing 
using the two larger ends of the T-connector.

Remove this connector

Analysis Liquid tubing

T-connector
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4. Insert the remaining piece of flexible tubing through the hole provided on the base of the 
sample handler.

5. Guide the tubing through the hole in the front chassis (just below the rinse pump) and 
connect it to the remaining barbed fitting of the T-connector.

6. Install the other end of the flexible tubing onto the sample transfer tubing connector on the  
side chosen in Step 5 of “Installing Sample Transfer Tubing” on page 36. 

7. Replace the cover of the liquid sample handler. Replace the retaining screws on the right 
side of the unit and retighten the thumb screw on the rear panel.

MasterTech Flexible tubing

Barbed connector

Make sure the side to which you connect the flexible tubing coincides with the one 
chosen in the arm of the MasterTech.
40                                         Jul 09



Saturn DigiSizer II 5205 Setting up the DigiSizer System 
Low-Volume Liquid Sample Handler

1. Locate the T-fitting of the stainless steel tubing of the drain manifold.

2. Use the 7/16- and the 1/2-in. wrenches provided in the accessories kit for this step. Hold 
the T-fitting secure with the 7/16-in. wrench, then use the 1/2-in. wrench to loosen and 
remove the topmost nut.

3. Remove the stainless steel plug from the nut. Be sure to store the plug in a secure location. 
If the MasterTech is disconnected, this plug will need to be reinstalled in the liquid sample 
handler.

4. Insert the stainless steel connector into the nut (the barbed end should be on the outside).

5. Reattach the nut to the T-fitting; tighten finger-tight. Then, using the two wrenches as 
shown above, tighten the nut 1/4 turn.

6. Insert one end of the flexible tubing (provided in the accessories kit) through the hole 
provided on the base of the sample handler.

T-fitting
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7. Guide the tubing through the hole in the front chassis and connect it to the barbed fitting of 
the T-connector. 

8. Install the other end of the flexible tubing onto the sample transfer tubing connector on the  
side chosen in Step 5 of “Installing Sample Transfer Tubing” on page 36. 

9. Replace the cover of the liquid sample handler. Replace the retaining screws on the right 
side of the unit and retighten the thumb screw on the rear panel.

Tubing connected to fitting

Make sure the side to which you connect the flexible tubing coincides with the one 
chosen in the arm of the MasterTech.
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Connecting Cables

1. Make sure the power switches on the rear panels of the analyzer, liquid sample holder,  
and MasterTech are in the OFF positions.

2. Insert one end of the serial cable (M/F 9-pin null) into the connector labeled RS-232 
Spare on the Liquid Sample Handling Unit.

3. Insert the other end of the cable into the connector labeled RS232 on the back of the 
MasterTech. 
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Installing the Analysis Program

This section includes instructions for configuring the ethernet connection, configuring the 
firewall setting, and installing either the Saturn DigiSizer 5205 Standard analysis software or 
the Saturn DigiSizer 5205 confirm analysis software. Follow the software installation 
instructions for the type of system purchased by the customer.

Entering Ethernet Settings

The computer and analyzer communicate by means of an ethernet connection. Before 
installing the Micromeritics software, you must check the ethernet settings in the Microsoft 
operating software and correct if necessary. The ethernet settings are as follows:

IP address field: 192.168.77.100

Subnet mask field: 255.255.255.0

If you need detailed instructions for performing this procedure, refer to Technical Bulletin 
Gen034.

Configuring the Firewall Setting

An ethernet firewall typically is enabled by default for the Windows XP and Windows Vista 
operating systems. Windows operating systems prior to these versions did not have firewalls. 
To prevent an initialization failure when running the Micromeritics software, you must turn off 
the firewall option between the computer and the analyzer. (Refer to Technical Bulletin  
Gen034 for details.) You must also do this for any third-party firewalls that may have been 
installed (refer to the firewall software manual or contact the system administrator for 
instructions).

Installing the Software

Be sure you have completed the following tasks before installing the software for the first 
time.

• Configure the ethernet port the analyzer will use.

• Disable the firewall setting for the connection between your computer and analyzer.

All programs should be closed before beginning installation of the Saturn DigiSizer 
software.
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• Connect the analyzer to the configured port and turn the analyzer on. 

Install the program as follows:

1. Turn on the analyzer and the liquid sample handler.

2. Insert the Saturn DigiSizer CD into the CD-ROM drive.

3. Select Start > Run from the Windows menu bar.

4. Enter the drive designator for the CD-ROM, followed by setup.  For example:   e:setup

Alternatively, you can click Browse, navigate to your CD-ROM drive, and select 
setup.exe.

5. Click OK; the Ethernet Introduction dialog is displayed. This screen outlines the steps 
that should be completed before installing the software.

If all of the steps have not been completed, click Cancel and perform the steps; then 
restart the installation program. Do not proceed with installation until these tasks have 
been completed.
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6. Click OK; the New Installation dialog is displayed.

The Destination Folder group box displays the amount of current disk space required for 
the analysis program, and the directory into which the application will be installed. If you 
prefer a different directory for installation, click Browse to select the desired directory.

7. Select the check box just below the Destination Folder group box to add an icon to your 
desktop; this enables quick access to the analysis program.

8. The DigiSizer icon is added to the Micromeritics folder by default. If you prefer a 
different folder, enter or select one from the drop-down list.

9. The Install this application for All Users check box enables you to allow or prohibit 
users other than the installer to access the application.

• Select the check box to allow access for all users logged onto Windows.
• Deselect the check box to allow access for only the user installing the application.
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10. Click Next; the Analyzer Configuration dialog is displayed.

a. In the Step 1 group box: 

b. In the Step 2 group box, enter the serial number(s) for the analyzer(s) you are 
attaching to this computer.

If... Then...
you are installing the 
analysis program at initial 
installation:

select the number of analyzers you are installing.

you plan to use the 
analysis program for 
offline data reduction:

select 0

you are moving an 
analyzer from another 
computer to this one:

select 0 
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11. Click Next; the Ethernet Ports dialog is displayed.

12. Choose one of the following:

13. Click Next; the calibration files are installed.

If you are installing two analyzers, the Calibration File Installation dialog instructing you 
how to proceed with installation of calibration files for the second analyzer is displayed. 
Read the instructions carefully; they are restated here.

a.  Remove this setup CD.

b. Insert the CD containing the files for the analyzer serial number requested. 

IMPORTANT: To prevent the CD from AutoPlay, hold down the Shift key before you 
close the CD door. Do not release the Shift key until the CD light stops blinking.

If .... Then ....
the port you configured 
is listed:

select the port and proceed to the next step.

the port you plan to use 
has been configured but 
is not listed:

Click Specify, the Specify Ethernet Port dialog is displayed.
Enter the remaining portion of the IP address in the enabled 
fields, then proceed to the next step.

If you selected 0 as the number of instruments to install, calibration files are not 
installed.
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c.  When the CD lights ceases to blink, click Next. After the calibration files are 
    installed, you will be prompted to reinsert the original setup CD.

14. Click Next; the Install Complete dialog containing the Readme file is displayed.

15. Click Finish to close the dialog.

16. Remove the program CD and store in a safe place. 

17. Display the Unit Configuration dialog as follows, and record the date and analyzer 
statistics on the Saturn DigiSizer Configuration form located in Appendix B.

a. Select Start > Programs > WIN5205 to start the analysis program.

b. Select Unit [n] > Unit Configuration.

c. Record the unit number (located in the title bar of the dialog).

d. Record the serial number and the IP address (displayed in the configuration group box).

e. Click Change and record the subnet mask (the series of numbers on the third line of the 
IP Setup dialog). Then click Cancel to close the dialog.

f. Click OK to close the Unit Configuration dialog.

18. Proceed to “Verifying Operation” on page 66.

The original program CD contains the calibration files specific to your instrument. 
Upgrade CDs do not contain calibration files. Therefore, it is important that you 
maintain your original program CD in a secure location in the event calibration files 
need to be reinstalled.
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Saturn DigiSizer 5205 confirm Systems

These instructions apply to confirm systems only.

The following procedures (numbered 1 through 9, with the exception of Step 3. Installing the 
Analysis Program) are to be performed by the customer’s network, Windows, or confirm 
application administrator. (Complete instructions are contained in the Administrator Utility 
User’s Guide for the Saturn DigiSizer 5205 confirm System.)

The instructions are included here to enable you to assist the customer’s administrator if 
necessary.

Preparing the Network

If the computer is to be connected to a network, have the customer’s Network Administrator 
install the computer on the network and set the network rights and permissions.

Determining File Locations

When the Micromeritics software is installed, it creates a default directory on the C drive and 
loads the files into this directory unless you select another location. If the customer wishes to 
install the files in a different directory, record the location below.

____ Install application in the default directory on C drive.

____ Install application in this directory: ________________________________________

        Password folder path:__________________________________________________

        Repository folder path:_________________________________________________

        Import path:_________________________________________________________

        Export path:_________________________________________________________

"Microsoft Windows and Network Administrator" 

The customer must provide one or more persons qualified to perform several 
complicated tasks using the skills of a Microsoft Windows Administrator and Network 
Administrator -- not just someone with Windows Administrator rights. 

This person must be on-site during installation.
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Installing the confirm Analysis Program

The installation CD shipped with the analyzer contains the Micromeritics software, which 
includes both the Micromeritics application and the Administrator Utility software. 

To install the software: 

1. Turn on the computer.

2. Ensure that the Microsoft Vista Business or Ultimate, or XP Professional operating system 
is running.

3. Print a test page to ensure that the proper printer drivers are installed.

4.  Insert the program CD into the CD-ROM drive.

5. Select Start from the Status bar, then Run from the Start menu.

6. Enter the name of the drive designator, followed by setup. For example: e:setup. 
Alternatively, you can click Browse, navigate to your CD-ROM drive, and select 
setup.exe.

7. Click OK; the Ethernet Introduction dialog is displayed. This screen outlines the steps 
that should be completed before installing the software.

8. If all of the steps have not been completed, click Cancel and perform the steps; then 
restart the installation program. Do not proceed with installation until these tasks have 
been completed.

The person who installs the software must have Windows Administrator rights.
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9. Click OK; a New Installation dialog, similar to the one shown below, is displayed. 

The Destination Folder group box displays the amount of current disk space, the amount 
of disk space required for the Micromeritics software, and the directory into which the 
application will be installed. If the location is not the default directory, click Browse to 
choose the directory.

10. If you want to run the Micromeritics software from the desktop, select the checkbox just 
below the Destination Folder group box to add an icon to the desktop.

11. The Micromeritics software icon is added to the Micromeritics folder by default. If you 
prefer a different folder, enter or select one from the drop-down list.

You may cancel the installation at any time by selecting Exit. If you do so, you must 
start the installation program from the beginning to install the Micromeritics software.

If the box labeled Install this application for All Users is checked (see Step 11 below), 
an icon is added to the desktop for all users
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12. The application can be accessed by all Windows users or only by the user who was 
logged in when the application was installed.

• To allow access to all Windows users, check the Install this application for All Users 
box. 

• To allow access only to the user who was logged into Windows during installation, do 
not check the Install this application for All Users box.

13. Click Next; the Auxiliary Path Setup dialog is displayed.  

The default locations of the application files shown in the screen above are displayed. 
Refer to “Determining File Locations” on page 50 for the location to be specified.

If a location is not the default location, use the Browse button to select another location.

14. Typically, the Seat number should remain as 01.  
 
The only time the Seat number should be changed is when the Micromeritics software is 
installed on multiple computers that share a common repository (directory) for files, 
perhaps on a network drive. The software uses this number to generate separate logs for 
each analyzer/computer combination.  
 
Review the Micromeritics Program license for the restrictions on the use of additional 
copies.
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15. Click Next; the Analyzer Configuration dialog is displayed.

16. In the Step 1 group box, click the radio button for the number of analyzers to be attached 
to this computer.In the Step 2 group box, enter the serial number(s) for the analyzer(s) 
you are attaching to this computer.   

If... Then...

you are installing the 
analysis program at 
initial installation:

select 1 for the number of analyzers, even when installing two 
analyzers. (After installation of the first analyzer, refer to 
Appendix A for installing the second one.)

you are reinstalling 
the analysis program 
on a new computer:

select the actual number of analyzers to be operated with this 
computer. (Refer to Appendix A for instructions on 
completing installation of two analyzers.)

you plan to use the 
analysis program for 
offline data 
reduction:

select 0

you are moving an 
analyzer from 
another computer to 
this one:

select 0

Additional hardware is required if you plan to attach two DigiSizers to one computer. 
Refer to Appendix A for information on attaching two analyzers.
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17.  Click Next; the Ethernet Ports dialog is displayed.

18. Choose one of the following:

19. Click Next; the calibration files are installed.

20. Click Next. The Installation Complete dialog box containing the Readme file is 
displayed. Use the scroll bar if you wish to read the contents of the file, then click Finish 
to close the dialog.

21. Remove the Setup CD and store in a safe place. The original Setup CD contains the 
calibration files specific to your instrument. Upgrade CDs do not contain calibration files. 
Therefore, it is important that you maintain your original Setup CD in a secure location in 
the event calibration files need to be reinstalled.

If.... Then....
the port you plan to 
use is listed:

select the port and proceed to the next step.

the port you plan to 
use has been config-
ured but is not listed:

Click Specify, the Specify Ethernet Port dialog is 
displayed.
Enter the remaining portion of the IP address in the 
enabled fields, then proceed to the next step.

If you selected zero (0) as the number of instruments to install, the Calibration dialog 
is not displayed.

The calibration files may be on another disk. In this case, you will be prompted to 
insert the disk containing the calibration files into the CD drive.
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22. You may be prompted to restart your computer after installation. If so, restart your 
computer before running the Micromeritics application.

23. Display the Unit Configuration dialog as follows, and record the date and analyzer 
statistics on the Saturn DigiSizer Configuration form located in Appendix B.

a. Select Start > Programs > WIN5205 to start the analysis program.

b. Select Unit [n] > Unit Configuration.

c. Record the unit number (located in the title bar of the dialog).

d. Record the serial number and the IP address (displayed in the configuration group box).

e. Click Change and record the subnet mask (the series of numbers on the third line of the 
IP Setup dialog). Then click Cancel to close the dialog.

f. Click OK to close the Unit Configuration dialog.

Entering Windows User Accounts

The Windows Administrator for the local computer must create user accounts in Microsoft 
Windows for all persons who will use the Micromeritics application software. If you need 
detailed instructions for performing this procedure, refer to Technical Bulletin Gen034.
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Adding Users to Windows User Groups

Once the software has been installed, the Windows administrator must add the Micromeritics 
application users to the four user groups created by the Micromeritics software during 
software installation.

• CfrAdministrator
• MicDevelopers
• MicAnalysts 
• MicService 

If you need detailed instructions for performing this procedure, refer to Technical Bulletin 
Gen034.

These user groups correspond to the four user profiles that can be assigned in the 
Administrator Utility as follows:

• The CfrAdministrator user group contains the profile for the application Administrator.  

• The MicDevelopers user group is created to contain users who will be assigned the Devel-
oper profile in the Administrator Utility. The Developer profile enables users to develop 
and enter analysis methods. A Developer has access to all functions of the Micromeritics 
application. 

• The MicAnalysts user group is created to contain users who will be assigned the Analyst 
profile in the Administrator Utility. The Analysts profile enables users to perform analyses 
using pre-defined analysis methods. An Analyst has access to a limited set of the 
Micromeritics application features.

• The MicService user group is created for Micromeritics Service Personnel. These users 
will be assigned the Developer profile in the Administrator Utility and have full access to 
the functions of the Micromeritics application. Although Service Personnel have the same 
access rights as Developers, a separate user group is created for them because Service Per-
sonnel have different directory and file access permissions.

In addition to creating user groups, the Micromeritics software also sets the Windows 
directory and file access permissions for each of these user groups.The default file permissions 
are included in Appendix A of the Administrator Utility User’s Guide. You may modify these 
settings if desired. 

 
It is recommended that at least two people are assigned to the group 
CfrAdministrator. 
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Recording User Information

As described previously, Micromeritics application users are to be assigned to one of the  
Windows user groups and to one of the two Micromeritics user profiles. The table below lists 
the Micromeritics application functions that can be performed by users with each profile.

User Information Worksheet

In order to have the information necessary when adding users and setting up profiles, enter the 
names of the users to be assigned to each of the user groups and to the corresponding 
Administrator Utility profiles in the table below. (This table was also included in the 
Preinstallation Checklist and Instructions and may have already been completed.)

 *User Name is the person’s Windows User ID.

** Service users should be added to the MicService Windows user group and assigned a 
     Developer user profile in the Administrator Utility.

Function Developer Analyst

Create sample records from templates

Analyze samples

Generate reports

List and print sample records and templates

Perform routine maintenance 

Enable manual control when the instrument is idle (if 
applicable)

Change limited analysis conditions before performing 
an analysis

Change report options after an analysis

Create templates (analysis methods) for analyst use

Perform all other Micromeritics application functions
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Application User Developer Analyst Service**

User 
Name*_________________________________________________

Full 
Name___________________________________________________

User 
Name*_________________________________________________

Full 
Name___________________________________________________

User 
Name*_________________________________________________

Full 
Name___________________________________________________

User 
Name*_________________________________________________

Full 
Name___________________________________________________

User 
Name*_________________________________________________

Full 
Name___________________________________________________

User 
Name*_________________________________________________

Full 
Name___________________________________________________

User 
Name*_________________________________________________

Full 
Name___________________________________________________

User 
Name*_________________________________________________

Full 
Name___________________________________________________
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Application User Developer Analyst Service**

User 
Name*_________________________________________________

Full 
Name___________________________________________________

User 
Name*_________________________________________________

Full 
Name___________________________________________________

User 
Name*_________________________________________________

Full 
Name___________________________________________________

User 
Name*_________________________________________________

Full 
Name___________________________________________________

User 
Name*_________________________________________________

Full 
Name___________________________________________________

User 
Name*_________________________________________________

Full 
Name___________________________________________________

User 
Name*_________________________________________________

Full 
Name___________________________________________________

User 
Name*_________________________________________________

Full 
Name___________________________________________________
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Setting Up User Profiles in the Administrator Utility

Starting the Administrator Utility

1. Select Start > Programs > Micromeritics > AdminUtil for DigiSizer 5205.

2. Enter "cfradministrator" in the User name field. 

3. Enter "password" in the Password field, then click OK. 

The following message displays: Your password has expired. You will not be able to 
login without changing your password.

4. Click OK; the Set Password dialog displays.

5. Enter a new password in the New password field. The password must contain a minimum 
of six alphanumeric characters.

6. Enter the password again in the Confirm new password field.

7. Click OK; the Administrator Utility screen displays.

This is the password that you will use to log onto the Administrator Utility and the 
Micromeritics software. When you enter a new password here, your Windows 
password is not changed.
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Entering Password Configuration Parameters

1. Click the Configuration tab to display the Configuration dialog.

2. The Password parameters you enter in this dialog will apply for all Micromeritics software 
users.

Enter the number of days in which a user’s password will expire in the Expire in field. 
This number of days goes into effect any time a user changes his password. 

If you enter zero (0) in this field, users’ passwords will not expire.

3. Enter the number of days prior to expiration that a user will be notified and asked whether 
he wants to change his password in the Warn user in field.

A zero (0) in this field means this function is not used.

4. The Remember field specifies the number of previous passwords to be stored in the 
password history file for each user. This file is checked when a user enters a new password 
to ensure that the password is unique.

Enter the number of passwords to be stored in the history file in the Remember field.

A zero (0) in this field means this function is not used.

5. Enter the number of times a user will be allowed to enter an invalid password when 
attempting to log into the application before the application is locked in the Disable 
account after field.

A zero (0) in this field means this function is not used.

6. You may specify that the User ID must match the user’s Windows ID and the user must 
be logged into the Windows application. This ensures that only the current Windows user 
can operate the Micromeritics application. Otherwise, any user with the same access level 
(Developer or Analyst) can log into the application.

To specify the matching requirement, click the Must match Windows user box to enter a 
check mark. 
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7. The Application locked box is checked anytime the application is locked. Click the box 
to lock or unlock the application. The application locks automatically when the specified 
number of failed logon attempts is reached.

8. When you have completed the Configuration dialog, click Save to save the information 
you entered.

Entering Application User Profiles

1. Click the Users tab to display the User dialog.

2. Click Add to display the Add User dialog.

3. Enter the user’s Windows User ID in the User Name field. 

4. Enter the name that will display in the application, stored in the system log, and used for a 
signature for this user in the Full Name field.

Full Name is used by the system log as the user’s electronic signature and must be 
unique.
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5. Designate "password" as a temporary password that the user can enter to access the 
application in the Password field for all users. This password is not saved in the password 
history file. When the user enters this password, he will be prompted to change it. The 
password to which he changes it will then be stored in the password history file.

The password must contain a minimum of six alphanumeric characters.

6. Select the user’s application access level by clicking the appropriate button. The user 
access level can be one of the following:

•   Administrator and Developer
•   Developer only 
•   Analyst only

7. The Password change date field is blank and disabled because this is a new user.

8. The Change password on next logon box is checked because the user’s assigned 
password is temporary and must be changed when the user logs onto the application. 

9. Click OK to save the user information and close the Add User dialog.

Setting Up a Service User Account

A user account should be set up during installation to provide Micromeritics service personnel 
access to system functions if a service call is required. 

To set up a service account:

1. Click the Users tab to display the User dialog.

When you enter a password here, the user’s Windows password is not changed.
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2. Click Add to display the Add User dialog.

3. Enter a Windows User ID to be used by service personnel in the User Name field. 

4. Enter Service in the Full Name field.

5. Enter a temporary password a service representative can enter to access the application in 
the Password field. When a service representative enters this password, he will be 
prompted to change it. 

The password must contain a minimum of six alphanumeric characters.

6. Click Developer for Access level. 

7. Click OK to save the user information and close the Add User dialog.
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Verifying Operation

Installation of the Saturn DigiSizer system is now complete. It is important to perform a series 
of checkout procedures to verify proper operation. These procedures are designed to assist you 
in verifying that all installation procedures were performed properly and that the Saturn 
DigiSizer and its peripheral equipment are working properly. If two analyzers are installed, 
perform the procedures in their entirety on each one. These procedures should be performed 
following installation, and may be performed following any subsequent equipment repairs, 
replacements, or relocation.

Entering Service Test Mode

The Saturn DigiSizer 5205 Analysis Program must be run in Service Test Mode to perform 
some of the verification procedures. To enter Service Test Mode:

1. Select Options > Service Test Mode to display the password dialog.

2. Enter the service password, then click OK.

Exiting Service Test Mode

Perform all operational verification tests in Service Test Mode. When you have finished 
operational verification, select Options > Service Test Mode to remove the checkmark and 
exit Service Test Mode

Service Test Mode remains enabled until you exit it or until the application is closed. 
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Saturn DigiSizer

Performing a Leak-Check Procedure

1. Turn on the equipment in this order:

a.  ultrasonic controller unit 
b.  MasterTech (if installed) - wait until the MasterTech has finished initialization and 
     stopped moving before proceeding to Step 2. 
c.  liquid sample handler 
d.  analyzer

2. Rinse the system with water to ensure that all tubing and sample cell are installed properly.

3. Open the front panel of the analyzer and remove the cover of the sample cell 
compartment.

4. Select Unit > Rinse > DigiSizer from the main menu.

5. Choose the Rinses option; specify 1, then click Start. 

6. Observe all tubing connections, as well as the sample cell.

• If leaks occur, click Cancel to stop the rinsing function. Close the front panel and select 
Drain on the Unit menu to drain the sample cell. Correct the problem, and repeat steps 
4, 5 and 6.

• If leaks do not occur, the DigiSizer is ready to perform analyses.

7. Replace the sample cell compartment cover and close the front panel.
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8. Select Show instrument schematic, then Enable manual control from the Unit menu.

9. Right-click on the circulating pump; choose Set speed. Enter 1500 if you have the 
standard liquid sampler installed, or 4000 if you have the Low-volume liquid sampler 
installed, then click OK.

10. Right-click again and turn on the circulating pump while observing the sample cell.

• If leaks occur, turn off the pump and open the drain valve immediately. Dry the sample 
cell area, correct the problem, and repeat the steps again.

• If leaks do not occur after approximately 10-15 seconds, turn off the pump and open the 
drain valve to drain the liquid from the system.

11. Turn the pump back on for 3 to 5 seconds to expel any additional liquid that may have 
remained in the pump, then turn it off.

12. Close the drain valve.

            MasterTech portion of
            schematic 
            (shown only if a 
            MasterTech is installed)

Circulating Pump
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Moving the Rotation Arm to the Specified Angle

1. If the Instrument Schematic is not shown on the computer screen, select Unit[n] > Show 
instrument schematic.

2. Select Unit[n] > Enable manual control.

3. Right-click on the rotation arm symbol and select Move.

4. Select Angle and type 65 in the degrees field.

5. Click OK; the rotation arm will start to move.

6. After the arm stops moving, 65.000 will display to the upper right of the rotation arm on 
the schematic.
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Fire the Laser 

This procedure can be performed with or without the analysis cell in place; no water is 
required.

1. If the Instrument Schematic is not shown on the computer screen, select Unit[n] > Show 
instrument schematic.

2. Select Unit[n] > Enable manual control.

3. Right-click on the Laser-beam Splitter Box.

4. Click Laser On.

5. Observe for ANY response from the Detector.

6. Click Laser Off.

Checking the Temperature

Observe the temperature reading on the schematic. The temperature should come within band 
in 15 minutes or less.
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Liquid Sample Handling Unit

Recording Application Version

1. Select Unit[n] > Unit Configuration to display the Unit Configuration dialaog.

2. Record the liquid sample handler application version number in the checklist.

Sample
Handler
Application
Version
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Checking Temperature of Fluid

1. If the Instrument Schematic is not shown on the computer screen, select Unit[n] > Show 
instrument schematic.

2. Select Unit[n] > Enable manual control.

3. Circulate cold water through the system.

4. Observe the temperature reading on the screen.

5. Pour hot water into the reservoir and observe the temperature change.

Temperature
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Checking the Pumps and Valve 

While performing the steps below, observe the symbols in the instrument schematic. A 
component’s symbol will change when the state of the component changes.

1. With the instrument schematic displayed, select Unit[n] > Enable manual control.

2. Check the Analysis liquid pump:

a.  Right-click on the Analysis liquid pump symbol, then select High.

b.  Right-click on the Analysis liquid pump symbol, then select Low.

c.  Right-click on the Analysis liquid pump symbol, then select Off.

3. Check the Rinse pump:

a.  Right-click on the Rinse pump symbol, then select On.

b.  Right-click on the Rinse pump symbol, then select Off.

4. Check the Circulating pump:

a.  Right-click on the Circulating pump symbol, then select On.

b.  Right-click on the Circulating pump symbol, then select Off.

c.  Right-click on the Circulating pump symbol, then select Set speed.

d. The Pump Speed Setting dialog is displayed. This dialog shows the current setting in  
RPMs. If it necessary to specify a different speed, enter the speed in the Pump speed 
field.

Rinse Pump    Analysis Pump

Circulating pump           Waste valve            
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Ultrasonic Probe

1. With manual control enabled, right-click the Ultrasonic Probe symbol on the instrument 
schematic screen, then select Probe on.

2. Right-click the Ultrasonic Probe symbol, then select Probe off.

3. Right-click on the Ultrasonic Probe symbol, then select Set probe intensity.

4. The Ultrasonic Intensity Setting dialog is displayed.

a.  Enter 40 in the Ultrasonic Intensity field, then repeat steps 1-3.

b.  Enter 60 in the Ultrasonic Intensity field, then repeat steps 1-3.

c.  Enter 80 in the Ultrasonic Intensity field, then repeat steps 1-3.

d.  Enter 100 in the Ultrasonic Intensity field, then repeat steps 1-3.

5. Check the Waste valve:

a. Right-click on the Waste valve displayed in the instrument schematic, then select Open.

b. Right-click on the Waste valve displayed in the instrument schematic, then select Close.

Ultrasonic
Probe
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AquaPrep

Performing a Leak Test

1. Make sure the AquaPrep tubing is properly installed in a plastic container of deionized 
water. (Refer to “Installing the AquaPrep Tubing” on page 27.)

2. Remove the top panel.

3. Turn the AquaPrep power switch to the ON position.

4. The pumps will run; observe the internal plumbing for leaks.

If you see a leak, TURN OFF THE UNIT IMMEDIATELY.

Water must not flow out of the vent tube on the front panel.

5. Verify that the front panel neon indicator is on. 

6. Observe the fan on the vacuum pump. It will be turning if the pump is running.

7. Identify the outlet tubing on the front panel. It is the right tubing.

8. Pull the outlet tubing out of the water. Verify that the water is discharging from this tubing. 

9. Turn the power switch OFF.

Checking the Flow Rate

1. Place an empty container on the floor beneath the AquaPrep. The vessel must have 
markings to indicate quantity of liquid, at least at the 1-liter level.

2. Place the outlet hose into the empty container. (The inlet hose must remain in the container 
of deionized water.)

3. Be ready to start timing the flow of water. 

4. Turn on the AquaPrep.

5. When the discharge of water begins, start the timer.

The AquaPrep works only with water; do not use any other liquid. Do not use water 
that contains a detergent or wetting solution.

A stopwatch is required for this procedure.
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6. When the level reaches 1 liter, stop the timer and turn off the unit.

7. The elapsed time must be within 20 to 60 seconds.

Performing a Bubble Test

1. Fill the small beaker supplied with the unit with water.

2. Place the beaker under the vent tube on the front of the unit. The end of the tube must be 
under the surface of the water.

3. Place the inlet tubing and the outlet tubing in the same container of deionized water.

4. Turn on the unit. You should see a stream of bubbles, which tapers off to a slow stream in 
a few seconds.

Vent Tube

Inlet tubing

Outlet Tubing
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5. Turn off the unit. You may hear the solenoid valve click as it opens to vent air back into 
the filter cartridge.

6. Turn the unit back on. You should again see a fast stream of bubbles, which tapers off after 
a few seconds.

Verifying MasterTech Operation

To verify operation, manually move each subsystem using the manual control option of the 
Saturn DigiSizer analysis program.

1. Turn on the MasterTech.

2. Fill a beaker with approximately 80 mL of water.

3. Place the beaker in the number 1 position of the MasterTech tray.

4. To test the ultrasonic probe, remove it from the holder and insert the tip of the probe well 
into the water.

5. While holding the probe tip underwater, press the ultrasonic probe AUTO/ON switch. You 
will hear a high-pitched sound, indicating that the probe is working properly.

6. Press the ultrasonic probe AUTO/ON switch again to turn off the probe.

7. Place the probe back into the holder.

Perform these steps only if the customer purchased a MasterTech. 

NEVER operate the ultrasonic probe without having the tip immersed into a 
liquid. Doing so may harm the probe and/or the driving electronics. DO NOT let the tip 
of the probe come in contact with a glass beaker. Doing so may shatter the beaker.

DO NOT press the ultrasonic probe AUTO/ON switch unless the probe and its cable 
are properly connected to the MasterTech. Doing so may harm the driving electronics.
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8. Select Unit [n] > Enable manual control. If the instrument schematic is not displayed, 
select Show instrument schematic.

9. Ensure that the Arm AUTO/LOAD switch on the front panel of the MasterTech is in the 
AUTO position.

10. Select Unit [n] menu > Initialize MasterTech.

A message is displayed indicating that initialization is in progress. The tray on the 
MasterTech rotates in a counterclockwise direction for one beaker position; the arm 
lowers to the Rinse position and returns.

The tray then continues to rotate until position 1 is reached. The beaker inserted in the tray 
in Step 3 should now be directly under the arm of the MasterTech. Make sure the beaker 
contains approximately 80 mL of water.

11. On the instrument schematic, select the symbol representing the MasterTech arm.

In each instruction for this step, first access the pop-up menu:

a. Select Move Arm Down two times.

b. Select Ultrasonic On; you will hear a high-pitched sound, indicating that the probe is 
operational. 

c. Select Ultrasonic Off to turn off the probe.

d. Select Stirrer On; the stirrer begins to operate.

MasterTech Arm                     MasterTech Arm  MasterTech Pump
                                                Pop-Up Menu                  

When manual mode is enabled, components on the instrument schematic have pop-
up menus displaying the options available for that component. Select the component, 
then click the right mouse button to access its pop-up menu.
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e. Select Stirrer Speed Fast.

f. Select Stirrer Off.

g. Select Move Arm Up.

h. Select Move To Beaker and enter the beaker position; note that the display is updated 
to reflect the position of the beaker tray. The picture on the screen will reflect whether 
or not a beaker is present.

12. Place the MasterTech pump switch on the front panel in the AUTO position, then select 
the MasterTech pump on the schematic. In each instruction in this step, first access the 
pop-up menu:

a. Select On; the MasterTech pump should begin operating (you will hear a whirring 
sound and the pump will begin to operate).

b. Check the direction of the flow of the MasterTech pump:

Select Flow Direction Load; allows suspension to flow from the MasterTech to the 
Saturn DigiSizer system for analysis.

Select Flow Direction Rinse; allows suspension to move from the Saturn DigiSizer 
system to the MasterTech. This direction is used to rinse the sample from the stirrer and 
transfer tube on the MasterTech.

c. Select Off to turn the pump off.

13. Rinse and prime the tubing of the MasterTech:

a.  Place an empty beaker in position 2 of the MasterTech tray.

b.  Select Unit [n] > Rinse > MasterTech Rinse then DigiSizer.

c.  Specify 2 as the beaker position, then click OK.

This concludes verification of operation of the MasterTech. If everything performed as 
described above, the system should be fully operational. If you encountered any problems, 
refer to Chapter 9 of the Saturn DigiSizer 5205 Operator’s Manual for troubleshooting 
procedures.

Beaker Position

MasterTech
Pump
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Preparing the Analysis Liquid

Water that has been freed of dissolved air (degassed water) is recommended for use as the 
analysis liquid. Water is easily and most efficiently degassed by using the AquaPrep degasser 
as described below. 
 

1. Fill the container with deionized water that has been filtered with a 1-micron filter.

The AquaPrep can aspirate water as high as 1-1/2 meters (5 feet); however the floor 
position is recommended.

2. Insert the ends of the inlet tubing into the water. Orient the tubing as follows:

• The end of the inlet tubing (supply) should be close to the bottom of the container.

• The end of the outlet tubing (return) should be just below, approximately 5 cm (2 in.), 
the surface of the water so that splashing does not reintroduce air into the liquid.

It is important that the tubing is arranged at different levels. This promotes circulation and 
ensures that all the liquid is exposed during the deaeration process.

3. Fill the beaker (supplied in the accessories kit) with deionized water and place it under the 
vent tube. Ensure that the end of the vent tube is submerged in the water approximately 
0.32 to 0.64 cm (1/8 to 1/4 in.).

If the DigiSizer is equipped with the standard sample handler and the rinse liquid is 
different from the analysis liquid, you do not have to use degassed water as the rinse 
liquid. Deionized water can be used for rinsing. 

The AquaPrep works only with water; do not use any other liquid. Do not use water 
that contains a detergent or wetting solution.

Inlet tubing

Outlet Tubing

Vent Tube
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4. Place the On/Off switch (on the rear panel) in the ON position (O); the power indicator 
should illuminate.

5. Allow the water to deaerate for two hours.

Water varies enormously in its dissolved air content depending on source, temperature, 
and time of year. Typically, the AquaPrep adequately reduces the content of dissolved air 
from 10 liters of filtered and deionized water in two hours or less.

6. Remove the tubes from the container of water.

You may wish to observe and record the bubble rate per minute before removing the tubes. 
This value could be useful as a guide for the adequacy of deaeration. For example, you 
may observe 20 bubbles per minute. If the background measurement you will perform 
next shows adequate deaeration, you can watch for approximately 20 bubbles per minute 
when deaerating a fresh supply of water.

7. Move the container close to the liquid sample handler. Then insert the analysis tubing 
from the liquid sample handler into the container.

Rinsing the Sample Cell

1. Select Unit > Rinse > DigiSizer; the DigiSizer Rinse dialog is displayed.

2. Select Rinses and enter 3; this should be sufficient since the cell contains no sample 
material.

3. Click Start; a dialog indicating that rinsing is in progress is displayed. When rinsing is 
complete, the dialog closes automatically.

Performing a Background Measurement

1. Select Unit > Background; the Background Measurement dialog is displayed.

2. Select Water from the Analysis liquid group box.

3. Click Next.

4. Set the flow rate to 6.

Be sure to turn off the AquaPrep when water is not being deaerated. Failure to have 
water circulating may damage the unit.

Be sure circulation of the liquid being degassed is promoted. 
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5. Select Report after measurement and choose Screen as the destination.

6. Click Next; a progress dialog is displayed, then the background measurement is displayed.

7. Click Done; a report is generated to the screen. You can print the report from this window 
if desired.

Creating a Sample Information File

For the analysis test included in this document you will need to create a sample information 
file, then start an analysis using the conditions specified in the file. Instructions are included 
for standard and confirm systems. Follow the instructions for the type of system purchased by 
the customer.

Standard Systems

Copying the Reference Material File into The Service Directory

A file containing analysis conditions for the reference material test is included on the Saturn 
DigiSizer 5205 CD. Using the data in this file will save you time by eliminating the need for 
entering analysis conditions individually. 

In order to use the provided sample information file, you should first create a Service 
subdirectory on the customer’s hard drive, then copy the file into the directory as described 
below:

1. Create a subdirectory in the C:\5205 directory named Service.

2. Copy this file from the CD into the C:\5205\Service directory: 
 
MRMXXXX.SMP 

where XXXX = the serial number of the unit.

If this background is unsatisfactory, you can measure another one by clicking Repeat. 
Refer to Appendix I of the Saturn DigiSizer 5205 Operator’s Manual for guidelines on 
determining an appropriate background.

Different lots of reference material may require editing data in these examples.
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3. When the file is copied in the Service directory, it is Read-Only. To remove the Read-
Only attribute, select the file from the Microsoft Explorer, right click to display the 
shortcut menu, select Properties, and click the Read-Only box to remove the check mark 
and the attribute. 

Creating a Sample File for Standard Systems

When instructed to create a sample information file, follow these steps:

1. Select File > Open > Sample Information File.

2. Enter a sample file name in the File name field and in the Installation Checklist.

Sample file names can contain up to 8 characters and the extension.SMP. 

3. Select OK. A confirmation dialog is displayed.     

These instructions are for Standard systems only.
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4. Select Yes to create the file. The Sample Information File dialog is displayed, with the 
name of the file you created in the Sample field.

5. Select Replace All.The Open Sample Information dialog displays. 

6. Select the C:\5205\Service directory from the Directories list.
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7. Select MRMXXXX.SMP (where XXXX = the serial number of the unit) from the Files 
list, then click OK.  

8. The Sample Information dialog is displayed

9. Enter your name in the Operator field.

10. Enter the instrument serial number in the Submitter field.

11. Select Close. A confirmation message is displayed. Select Yes to save the file and close 
the dialog.

This copies the analysis conditions from the file in the C:\5205\Service directory into 
your sample file so you do not have to enter the analysis conditions individually.
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Confirm Systems

Creating a Service Directory

To create a subdirectory:

1. Select Options > Add Archive Location.

2. Select MICService in the Category field.

3. Enter Service <current date> in the Sub-category field.

4. Click OK.

Creating a Sample File for confirm systems

When instructed to create a sample information file, follow these steps:

1. Select File > New > Sample Information; the Create a Sample Information File dialog 
containing the available templates is displayed.

2. Select the C:\5205\Service directory from the Directories list.

3. Choose the Saturn DigiSizer Garnet Reference Material template.    

4. Click Create; the Sample Information dialog is displayed.

5. Enter a sample file identifier in the Sample field.

Sample file identifiers can contain up to 42 characters. 

6. Enter your name in the Operator field.

7. Enter the instrument serial number in the Submitter field.

8. Click Save: the Save As Sample Information dialog is displayed.

9. Save the sample file in the Service <current date> directory, then click Save.

10. Select Close. A confirmation message is displayed. Select Yes to save the file and close 
the dialog.

These instructions are for confirm systems only. For Standard systems, refer to 
“Creating a Sample File for Standard Systems” on page 83

A Developer user profile is required to create a sample information file.

This copies the analysis conditions from the template in the C:\5205\Service directory 
into your sample file so you do not have to enter the analysis conditions individually.
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Performing a Reference Material Test

1. Select Unit > Sample Analysis from the main menu; the Sample Analysis dialog is 
displayed with the Open Sample Information dialog positioned on top.

2. Navigate to the sample file you just created. Select the file, then OK; the Sample Analysis 
dialog is displayed again.

3. Click Report after analysis and choose Printer as the destination.

4. Click Next; a second view of the Sample Analysis dialog is displayed.

5. Slowly add sample to the reservoir; add enough to provide a beam obscuration of 13 to 
15%. If the beam obscuration exceeds 15%, the DigiSizer will adjust the concentration 
automatically.

6. When the beam obscuration is in the appropriate range, click Next to begin analysis and 
data collection.

7. When the analysis has finished and reports are printed, remove the reports from the 
printer. The Combined Report will state whether the analysis passed (results were within 
specifications) or failed (results were not within specification).

8. Include the printed results in the installation documentation sent to Micromeritics.
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Part 2: Installation Checklist

Checklist Description

The tables in the checklist contain the columns described below

Column Description/Action

Procedure Perform the procedure described in this column.

Evaluation Code Circle an evaluation code for each procedure according to the 
following criteria:

P = Pass                     
Indicates that this procedure has been successfully completed without 
error.

F = Fail
Indicates that this procedure has been unsuccessful and prevents the 
instrument from being installed for use.

N/A = Not Applicable     
Indicates that this procedure does not apply to your system.

Initial/Date Enter your initials and the date. 

If the procedure was completed by another person, that person should 
enter his or her initials and the date.
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Preparing for Installation 

Setting Up the DigiSizer System

Procedure Evaluation 
Code

Initial/
Date

Review the Preinstallation Instructions and Checklist and ensure that the 
laboratory is prepared for installation.

P     F    N/A

Ensure that the required personnel are available. P     F    N/A

Ensure that all equipment has been unpacked and verified using the 
packing list.

P     F    N/A

Procedure Evaluation 
Code

Initial/
Date

Place the DigiSizer on a work surface with the back panel facing the 
front

P     F    N/A

Select the DigiSizer line voltage. P     F    N/A

Install the fuse(s). P     F    N/A

Select the computer line voltage. P     F    N/A

Connect ethernet cable. P     F    N/A

Connect power cord. P     F    N/A

Connect computer cables. P     F    N/A

Install the Liquid Sample Handler.  P     F    N/A

Install the sample cell. P     F    N/A

Install the liquid sample tubing. P     F    N/A

Connect the Ultrasonic Controller Unit. P     F    N/A

Install the AquaPrep. P     F    N/A
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Installing the MasterTech (if used)

Installing the Analysis Program (Standard Software Only)

Procedure Evaluation Code 
(circle one)

Initial
/Date

Remove packing material. P    N    F    N/A

Select voltage. P    N    F    N/A

Insert fuse(s). P    N    F    N/A

Turn on the MasterTech. P    N    F    N/A

Install the ultrasonic probe. P    N    F    N/A

Install beaker tray. P    N    F    N/A

Install sample transfer tubing. P    N    F    N/A

Connect RS232 cable from MasterTech to Liquid Sample Handler. P    N    F    N/A

Procedure Evaluation Code 
(circle one)

Initial
/Date

Install the 5205 standard software P    N    F    N/A
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Installing the Analysis Program (Confirm Software Only)

Procedure Evaluation Code 
(circle one)

Initial
/Date

Determine file locations. P    N    F    N/A

Install the 5205 confirm software P    N    F    N/A

Add application users to Windows user groups. P    N    F    N/A

Start the Administrator Utility program and enter the Administrator user 
profile.

P    N    F    N/A

Enter password configuration parameters in the Administrator Utility 
program and record:

Expire_____________________

Warn______________________

Remember__________________

Disable_____________________

Must match Windows user_____

P    N    F    N/A

Enter application user profiles. P    N    F    N/A

Enter service profile. P    N    F    N/A
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Verifying DigiSizer System Components

Procedure Evaluation Code 
(circle one)

Initial
/Date

Enter service test mode. P    N    F    N/A

Leak check the DigiSizer. P    N    F    N/A

Move rotation arm to the specified angle. P    N    F    N/A

Fire laser. P    N    F    N/A

Ensure that temperature is within band. P    N    F    N/A

Record the application version of the sample handler:_______________ P    N    F    N/A

Check temperature of fluid. P    N    F    N/A

Test analysis liquid pump. Add warm water and ensure that the 
temperature reading on the screen changed.

P    N    F    N/A

Test rinse pump. P    N    F    N/A

Test circulating pump. P    N    F    N/A

Test waste valve. P    N    F    N/A

Test ultrasonic probe. P    N    F    N/A

Leak check the AquaPrep. P    N    F    N/A

Test the AquaPrep flow rate. Elapsed time should be within 20 to 60 
seconds.

P    N    F    N/A
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Verifying the MasterTech (if used)

Preparing the System for Operational Tests

Procedure Evaluation Code 
(circle one)

Initial
/Date

Test ultrasonic probe AUTO/ON switch. P    N    F    N/A

Initialize MasterTech. Ensure that the tray rotates until beaker position 
one is reached.

P    N    F    N/A

Test arm movement. P    N    F    N/A

Test stirrer. P    N    F    N/A

Test ultrasonic probe. P    N    F    N/A

Test pump. P    N    F    N/A

Rinse and prime tubing. P    N    F    N/A

Procedure Evaluation Code 
(circle one)

Initial
/Date

Prepare analysis liquid. P    N    F    N/A

Rinse sample cell. P    N    F    N/A

Perform a background measurement. P    N    F    N/A

Create a sample information file. P    N    F    N/A
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Performing Reference Material Test

Procedure Evaluation Code 
(circle one)

Initial
/Date

Record reference material lot number:______________________ P    N    F    N/A

Perform a reference material analysis. P    N    F    N/A

Record expected results of the reference material analysis (listed in 
the reference material instructions booklet):

Volumetric arithmetic mean equivalent spherical diameter = _________

Volume median equivalent spherical diameter = __________

90 Cumulative volume % finer than __________

10 Cumulative volume % finer than __________  + ____µm 

Record the tolerance level for all the following values _______

Cumulative volume % finer at 10.0 µm = _________
Cumulative volume % finer at 8.0 µm = __________
Cumulative volume % finer at 6.7 µm =  __________
Cumulative volume % finer at 5.7 µm = __________
Cumulative volume % finer at 4.8 µm = __________
Cumulative volume % finer at 3.9 µm = __________
Cumulative volume % finer at 3.0 µm = __________
Cumulative volume % finer at 2.1 µm = __________
Cumulative volume % finer at 1.2 µm =__________

P    N    F    N/A
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Record the actual results of the analysis:

Volumetric arithmetic mean equivalent spherical diameter = _________

Volume median equivalent spherical diameter = __________

90 Cumulative volume % finer than __________

10 Cumulative volume % finer than __________  + ____µm 

Cumulative volume % finer at 10.0 µm = _________

Cumulative volume % finer at 8.0 µm = __________

Cumulative volume % finer at 6.7 µm =  __________

Cumulative volume % finer at 5.7 µm = __________

Cumulative volume % finer at 4.8 µm = __________

Cumulative volume % finer at 3.9 µm = __________

Cumulative volume % finer at 3.0 µm = __________

Cumulative volume % finer at 2.1 µm = __________

Cumulative volume % finer at 1.2 µm =__________

P    N    F    N/A

P    N    F    N/A

P    N    F    N/A

P    N    F    N/A

P    N    F    N/A

P    N    F    N/A

P    N    F    N/A

P    N    F    N/A

P    N    F    N/A

P    N    F    N/A

P    N    F    N/A

P    N    F    N/A

P    N    F    N/A

Procedure Evaluation Code 
(circle one)

Initial
/Date
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Exceptions 

Procedures categorized as Fail should be explained below.

Procedure Comments Initial/
Date
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Signatures

Installer

Customer Representative

Name:
(please print)

Signed:

Position: Date:

Company: Field Service Report (FSR Number):

Name:
(please print)

Signed:

Position: Date:

Company: Field Service Report (FSR Number):
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Final Documentation

In order to provide consistent instrument service, Micromeritics retains records of installation, 
operational verification, and calibration data in its Service Support Center in Norcross, 
Georgia, USA. After completing the installation process, representatives of Micromeritics 
who install instruments are required to send the documents listed below to Micromeritics for 
inclusion in the customer's instrument history.

The documents to be sent to the Micromeritics Service Support Center are:

• Completed Field Service Report

• Completed and signed, DigiSizer 5205 Installation Checklist: 

• Reference Material Analysis Sample Files.

• Calibration files if calibration data were changed during installation.
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Appendix A: Attaching Multiple Analyzers to One Computer

You can install up to two Saturn DigiSizer analyzers to one computer, allowing for high 
sample throughput. Each analyzer can also have a MasterTech autosampler attached. The 
MasterTech allows you to queue up to 18 samples for analysis. Each sample is transferred to 
the Saturn DigiSizer automatically, requiring no further operator intervention until the queued 
analyses are complete. 

The following items are required for installing two analyzers:

• One Ethernet switch
• One straight Ethernet cable for each Saturn DigiSizer to be attached
• One straight Ethernet cable for connecting the computer and the Ethernet switch

When attaching two analyzers to one computer, installation and configuration depends on 
whether you are:

• installing two analyzers from the factory, each with a default configuration, to a single 
computer

• installing two existing, configured analyzers on a new computer, requiring a new 
install of the analysis program

• moving an existing, configured analyzer from one computer to another one that already 
has a Saturn Digisizer installed 
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Installing Analyzers with Default Configurations

These instructions are for installing a second analyzer with a default configuration to a 
computer that already has an analyzer (Unit #1) installed.

1. Connect the ethernet switch (refer to the manufacturer’s manual for instructions).

2. Exit the analysis program (if operating) and turn the installed analyzer (Unit #1) off.

3. Disconnect the Ethernet crossover cable that is currently connected to the analyzer and 
computer, and store in a safe place.

4. Connect one end of a straight Ethernet cable to the Ethernet card (exposed on the back 
side of the computer) and the other end to a port on the Ethernet switch.

5. Connect one end of a straight Ethernet cable to the connector labeled Ethernet on the 
rear panel of Unit #1 and the other end to a port on the Ethernet switch.

6. Turn the analyzer on.

7. Start the analysis program. This step is simply to ensure that all cable connections are 
secure. If the program fails to initialize the communications link, check cable 
connections.

8. Exit the analysis program. 

9. Disconnect the Ethernet cable for Unit #1 from the Ethernet switch; do not disconnect the 
cable from the analyzer.

10. Connect one end of another straight Ethernet cable to the connector labeled Ethernet on 
the rear panel of Unit #2 and the other end to a port on the Ethernet switch.

11. Turn Unit #2 on.

12. Start the analysis program. The analysis program does not know that a second unit has 
been attached at this time; therefore, all unit references still display as Unit #1. Because 
of this, you may receive Error Message 6133; simply click to clear the message.

13. Click OK to acknowledge and close the calibration message.

14. Select Unit configuration from the Unit 1 menu; the Unit Configuration dialog is 
displayed.

15. Click Change; the Unit IP Setup dialog is displayed.
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16. Enter 2 for the final configuration of this unit (first line).

17. Enter 102 as the new IP address for Unit #2 (fourth field of second line).

18. Record the IP address and subnet mask on the Saturn DigiSizer Configuration form (the 
last page of this appendix).

19. Click OK to close the Unit IP Setup dialog, 

20. Record the Unit number and serial number on the Saturn DigiSizer Configuration form. 
Also record the date, then click OK to close the Unit Configuration dialog.

21. Exit the analysis program.

22. Turn Unit #2 off.

23. Reconnect the Ethernet cable of Unit #1 to the Ethernet switch.

24. Insert the analysis program CD into the CD-ROM drive.

25. Select Start from the Task bar, and Run from the Start menu.

26. Enter the drive designator of the CDROM drive, followed by SETUP; for example, 
e:setup.

27. Click OK; the Setup Welcome dialog is displayed.
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28. Select Add an analyzer and click Next; the Ethernet Introduction dialog is displayed. 
This screen outlines the steps that should be completed before installing the software.

29. Make sure the steps are completed, then click OK. The Set up analyzer being added 
dialog is displayed.

30. Enter the serial number of the analyzer you are adding.
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31. Click Next; the Calibration File installation dialog is displayed.

32. Ensure that the CD-ROM drive is shown as the source location; if not, click Browse to 
select the correct drive.

33. Click Finish to install the calibration files; follow the instructions displayed in the 
dialogs.

34. Turn both units on and start the analysis program.

Installing Existing Configured Analyzers to a New Computer

 
Use the instructions in this section to install two existing configured, analyzers on a different 
computer (perhaps a newly purchased one) that does not have the analysis program installed.

1. Install the analysis program on the new computer. When prompted for the number of 
analyzers you plan to install, specify the actual number you are installing.

2. Use Windows Explorer to edit the application file (either WIN5205.ini for standard 
software or cfr5205.ini for confirm software):

a. Right-click on the Start button and select Explore.

b. Open the directory where the analysis program is installed (the default is either 
C:\5205 for standard software or C:\cfr5205 for confirm software).

c. Double-click on cfr5205.ini or WIN5205.ini. This opens Notepad, displaying the ini 
file.

d. Navigate (or page-down) to the section titled [Unit 1].

e. Confirm that there is a TCPAddr= entry and that it matches the address recorded on 
the Saturn DigiSizer Configuration form for this unit. If the entry is not there, add it 
in the following format:  
 

TCPaddr=[nnn.nnn.nnn.nnn]  
 
where n’s are replaced with the IP address recorded on the Saturn DigiSizer 
Configuration form. 
 
If the TCPAddr= entry is different from the one recorded on the Saturn DigiSizer 
Configuration form, enter the correct one.

f. Navigate to the section titled [Unit 2] and repeat Step e.

g. Select File, Save to save the changes and close Notepad.

3. Disconnect the ethernet cable from the old computer and connect it to the new one.

4. Turn on installed analyzers and start the analysis program.
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Moving an Existing Configured Analyzer to Another Computer

Use the instructions in this section if you have a configured analyzer that you wish to move to 
a different computer that already has an analyzer and the analysis program installed.

1. Review the Saturn DigiSizer Configuration forms for both the current and destination 
computers. If there are duplicate IP addresses for analyzers (in most cases, there will be), 
it is best to change the IP address using the current computer before moving the analyzer.

a. Turn on installed analyzers and start the analysis program.

b. Select Unit configuration from the Unit [n] menu and click Change; the Unit IP 
Setup dialog is displayed.

c. Enter a new address for the analyzer you are uninstalling and record it on the Saturn 
DigiSizer Configuration form for the destination computer. For example, the current 
analyzer is nnn.nnn.nnn.101 and you have an analyzer already installed on the 
destination computer with the same IP address. Specify the address for the analyzer 
you are uninstalling as nnn.nnn.nnn.102.

d. Click OK to close the Unit IP Setup dialog, then again to close the Unit Configuration 
dialog.

2. Exit the analysis program and turn off all analyzers.

3. Disconnect the Ethernet cable of the analyzer from the current computer (or Ethernet 
switch) and reconnect to the Ethernet switch for the destination computer.]

4. On the current (source) computer, select Start from the Task bar, and Run from the Start 
menu.

5. Enter the drive designator of the CDROM drive, followed by SETUP; for example, 
e:setup.

6. Click OK; the Setup Welcome dialog is displayed
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7. Select Move an analyzer from one PC to another PC and click Next; the Ethernet 
Introduction dialog is displayed. This screen outlines the steps that should be completed 
before installing the software

8. Make sure the steps are completed, then click OK. 

9. Select Source PC, then click Next; the following dialog is displayed.
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10. From the drop-down list in the Step 1 group box, select the analyzer that is to be moved 
from this computer.

11. Click Browse in the Step 2 group box to select a location for storing the calibration and 
status files associated with the source computer. If possible, the location should be a 
shared network drive. If this is not possible, select a local folder and then use a transfer 
utility to copy its contents from the Source PC to the Destination PC.

12. Click Finish; the files are copied to the specified location and the setup Welcome screen 
is displayed. 

13. Click Exit to close the dialog, then remove the CD-ROM from the source computer.

14. Insert the CD-ROM in to the CD-ROM drive of the destination computer, then start the 
Setup program.

15. Select Move an analyzer from one PC to another PC; the Move analyzer operation dialog 
is displayed.

16. Select Destination PC, then click Next; the Move analyzer information to the PC dialog 
is displayed.In the Step 1 group box, enter the serial number of the unit you are adding.

17. Enter the location of the files that were stored previously.

18. Click Finish; the files are transferred and the setup Welcome screen is again displayed.

Sample and parameter files are not copied and moved with the analyzer. Use a file 
management program such as Explorer to move these files, then the Import function to 
import them into the application.
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19. Click Exit to close the dialog.

20. Remove the CD-ROM from the computer and store in a safe place.

21. Use Windows Explorer to edit the application file (either WIN5205.ini for standard 
software or cfr5205.ini for confirm software):

a. Right-click on the Start button and select Explore.

b. Open the directory where the analysis program is installed (the default is either 
C:\5205 for standard software or C:\cfr5205 for confirm software).

c. Double-click on cfr5205.ini or WIN5205.ini. This opens Notepad, displaying the ini 
file.d.Navigate (or page-down) to the section titled [Unit 1].

e. Confirm that there is a TCPAddr= entry and that it matches the address recorded on 
the Saturn DigiSizer Configuration form for this unit. If the entry is not there, add it 
in the following format:  
 

TCPaddr=[nnn.nnn.nnn.nnn]  
 
where n’s are replaced with the IP address recorded on the Saturn DigiSizer 
Configuration form. 
 
If the TCPAddr= entry is different from the one recorded on the Saturn DigiSizer 
Configuration form, enter the correct one.

f. Select File, Save to save the changes and close Notepad.

22. Turn on both analyzers and start the analysis program.
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Appendix B: Saturn DigiSizer Configuration Management 
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Appendix C: Selecting the Voltage and Installing Fuses with 
Other Input Power Configuration

On some instruments, the input power connector has a removable cover instead of the hinged 
cover desribed in this document. If this type of configuration is used on the instrument being 
installed, follow the instructions below.

1. Make sure the power cord is not connected to the instrument.

2. Check the voltage setting on the rear panel of the instrument. 

• If the voltage is correct:

 a. Using a pointed object, remove the fuse block and cover assembly from the power 
connector at the rear of the instrument. (The illustrations below represent a typical 
instrument.)

 b.  Proceed to Step 6.

•  If the voltage is incorrect, remove the fuse block cover as described above, then proceed 
to Step 3.

The power cord must be disconnected from the instrument before removing the 
cover from the input power connector. Failure to disconnect the power cord could 
result in electrical shock.
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3. Pull the voltage selector card straight out of the power connector housing.

4. Orient the voltage selector card so that the desired voltage is indicated at the bottom. 
Orient the indicator pin so that it points upward as shown in the following illustration.

5. Insert the voltage selector card into the power connector housing with the edge containing 
the desired voltage first and with the printed side to the left.

Voltage

Indicator Pin

Printed side
of card

The power cord must be disconnected from the instrument when installing or 
replacing fuses. Failure to disconnect the power cord could result in electrical 
shock.
C-2                Jul 09



Saturn DigiSizer II 5205 Appendix C
6. Fuse the input power line according to local safety practices. The input power connector 
can be used with either a single-fuse arrangement or a double-fuse arrangement, as shown 
in the following illustration.

a.   Observe the position of the fuse block, using the previous figure for reference. If the 
single-fuse arrangement is desired, position the fuse block so that the side with the 
single-fuse slot and the jumper bar is away from the cover. 

     If the double-fuse arrangement is desired, position the fuse block so that the side with 
the double-fuse slots is away from the cover.

b.    If the fuse block is positioned properly for the fusing desired, proceed to Step c. 

If the fuse block is not positioned properly for the fusing desired:

1) Remove the fuse block retaining screw. 
2) Lift the fuse block from the cover. 
3) Rotate the fuse block. 
4) Mount the fuse block to the cover. 
5) Replace the retaining screw.

Fuse Block

Fuse

Retaining Screw

Fuses

Cover

Jumper Bar

 Fuse
Fuse
Block

Cover

Fuse Block

Double-Fuse Arrangement                       Single-Fuse Arrangement

The fuses used in the instrument must be identical in type and rating to that 
specified. Use of other fuses could result in electrical shock and/or damage to the 
instrument.
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c.    Insert the appropriate fuse(s) for the input power source. Refer to the chart below for 
the appropriate fuse ratings for the DigiSizer, AquaPrep and MasterTech.

7. Insert fuse block and cover assembly into the input power connector (as shown in the 
following illustration) and snap it into place. Once the fuse block and cover assembly are 
in place, the position of the indicator pin shows the input power selected.

Instrument Power Source Fuse

Saturn DigiSizer 5205 100-115 VAC 3 AG, 1.5 Amp Slow-Blow

200-240 VAC 5 x 20 mm, 1.25 Amp Slow-Blow

AquaPrep 100-120 VAC 2.0 Amp Slow-Blow

200-240 VAC 1.0 Amp Slow-Blow

MasterTech 100-120 VAC 3 AG, 2.0 Amp Slow-Blow

200-240 VAC 5 x 20 mm 1.0 Amp Slow-Blow
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